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Welcome to Edit Well — the interactive newsletter 
for Final Cut Studio!

I am delighted to join with Peachpit to create this 
newsletter for the serious Final Cut user. I specifi cally 
want to thank Nancy Ruenzel and Jennifer Bortel 
at Peachpit for their support and encouragement.

As both a video editor and teacher, I’ve found that 
it’s easy to get overviews and product information 
from the Internet or monthly magazines. But it’s very, 
very diffi cult to fi nd accurate, well-written, and in-depth 
help on how to use the advanced features of Final 
Cut Studio successfully.

That’s where Edit Well comes in. Look through 
the pages of this premiere issue and you’ll discover 

articles from Tom Wolsky, Bruce Nazarian, Kevin 
Monahan, Mark Spencer, and Philip Hodgetts—
leading-edge writers with world-class reputa-
tions and a deep understanding of how to use 
Final Cut. 

Plus, we’re taking advantage of our online 
delivery to include audio and video elements. 
For instance, in this issue we have audio inter-

views with Paul Saccone,  Apple product 
marketing manager for Final Cut Studio; 
and Kym Rogers, manager of AV Central, 

an Apple Pro-Video dealer in Adelaide,  Australia; 
plus a video tutorial showing you how to optimize 
your system for Final Cut. You can play these 
elements by clicking the appropriate buttons on 
Pages 19 and 23.

Each issue contains focused, in-depth articles, key-
board shortcuts, audio interviews, video tutorials, and 
a wide variety of tips and techniques you can use to 
edit faster, with better quality, and improve your editing 
skills so you can get a step ahead of the competition.

I am very interested in what you’d like us to 
present, because everything we cover is designed 
to help you make the most of Final Cut Studio. 
Share your opinions with me at editor@editwell.com.

Finally, in order for this newsletter to succeed, we 
need you to subscribe.  We have a special introductory 
price of $59.99 for a full year of 12 issues. If Final Cut 
is important to you, we believe this newsletter is a 
worthwhile investment in your career.

This is going to be fun. Welcome to Edit Well!

Larry Jordan

Welcome

http://www.peachpit.com/editwell


JUNE 2006  | 4

In this Issue:  Contents | Writers | NAB | Mattes | Plug-ins | Compression | Tutorial | Scopes | Shortcuts | Auto Select

EditWell

Philip Hodgetts
Visionary and technologist 
Philip Hodgetts is the managing 
editor and primary host of 
Digital Media BuZZ and the 
president of Intelligent 

Assistance. He is co-developer of Intelligent 
Assistant, the Pro Apps Hub, and the technologies 
that support them. Philip has been working in 
digital postproduction for more than 10 years 
and in production for close to 25, working on 
everything from national TV commercials to 
corporate video to long-form documentary. For 
more than a decade, Philip has been accurately 
predicting the future directions of the industry. 
Visit his website at www.intelligentassistance.com.

About Our Contributors

Kevin Monahan
Kevin Monahan is a video 
editor and motion graphics 
artist living in San Francisco. 
He is the president and 
co-founder of the world’s 

fi rst FCP User Group, SF Cutters. Kevin has 
worked on projects at such companies as Apple, 
Electronic Arts, and Pixar. He is also the author 
of Motion Graphics and Effects in Final Cut Pro
(Peachpit, 2004). Visit Kevin’s websites at www.
fcpworld.com and www.sfcutters.org.

Larry Jordan
Larry Jordan is a consultant 
and Apple Certifi ed Trainer 
in Digital Media with more 
than 25 years’ experience as 
a television producer, director, 

and editor with national broadcast and corporate 
credits. Based in Los Angeles, he’s a member of 
both the Directors Guild of America and the 
Producers Guild of America. Larry has also been 
recognized as one of the Top 100 Corporate 
Producers in America. He has written two books 
on Final Cut: Hands-on Training for Final Cut Pro 
HD (Peachpit, 2004) and Hands-on Training for 
Final Cut Pro 5 (Peachpit, 2005). Visit his website 
at www.larryjordan.biz.

Bruce Nazarian,
“the DVD Guy”
Bruce Nazarian is an award-
winning DVD producer and 
author, and a member of the 
DVD Association’s National 

Board of Directors. Bruce recently completed 
DVD Studio Pro 4: The Complete Guide to DVD 
Authoring with Macintosh (McGraw-Hill, 2006). 
He is president of Gnome Digital Media, his DVD 
and media production company in Los Angeles. 
Visit his website at www.Recipe4DVD.com.

Mark Spencer
Mark Spencer is a freelance 
producer and editor working 
in the San Francisco Bay Area. 
His production company, 
Day Street Productions, 

focuses on corporate video production and 
fi nish editing for documentaries. He is an 
Apple Certifi ed Trainer for Final Cut Pro, 
Motion, and DVD Studio Pro, and he is the 
author of Motion for Mac OS X Visual QuickStart 
Guide (Peachpit, 2004). Visit his website at 
www.daystreet.com.

Tom Wolsky
Tom Wolsky is a former 
ABC News producer 
and operations manager 
in London and New York. 
He now has a boutique 

production company in northern California 
and has been teaching FCP since it came out. 
He teaches for Digital Media Academy and has 
written a number of books, articles, and DVDs 
on Final Cut Pro, Final Cut Express, video 
production, and video journalism. Visit his 
website at www.SouthCoastTV.com.

http://www.intelligentassistance.com
http://www.larryjordan.biz
http://www.daystreet.com
http://www.sfcutters.org
http://www.fcpworld.com
http://www.fcpworld.com
http://www.Recipe4DVD.com
http://www.southcoastTV.com


JUNE 2006  | 5

In this Issue:  Contents | Writers | NAB | Mattes | Plug-ins | Compression | Tutorial | Scopes | Shortcuts | Auto Select

EditWell

Noah Kadner: 
Shooting Tapeless: Panasonic P2 Workfl ow
Alexis Van Hurkman:
Show Me Some Skin: Secrets of Color Correction
Larry Jordan:
Mixing Your FCP Projects in Soundtrack Pro
Graeme Nattress:
Creating Your Own Effects with FX Script
Mark Spencer:
25 Killer 3rd Party Plug-Ins—Part 2
Bruce Nazarian:
Check Your DVD Motion Menu IQ

JUNE 2006
VOL 1  NO 1

EDITOR: 
Larry Jordan

CONTRIBUTING WRITERS: 
Philip Hodgetts  |  Kevin Monahan  |  Bruce Nazarian

Mark Spencer  |  Tom Wolsky
COPY EDITING: Robin Drake  |  LAYOUT & DESIGN: Katie Furlong

FOR PEACHPIT,
THE CREATIVE GROUP OF PEARSON EDUCATION

VICE PRESIDENT/PUBLISHER: Nancy Aldrich-Ruenzel
ASSOCIATE EDITORIAL DIRECTOR: Jennifer Bortel

DIRECTOR OF MARKETING: Scott Cowlin
MARKETING COMMUNICATIONS SPECIALIST: Amy Fandrei

PRODUCT MARKETING MANAGER: Damon Hampson
MARKETING MANAGER: Kole Hicks
GRAPHIC DESIGNER: Aren Howell

THE INTERACTIVE NEWSLETTER FOR FINAL CUT STUDIO

Subscription email: 
subscriptions@editwell.com
Editorial email: 
editor@editwell.com
Letters email:
letters@editwell.com

ADVERTISING SALES: 
Phone:  (516) 628-8555
Email:  sales@editwell.com

Subscriptions are $59.99 per year. Individual 
issues may be purchased for $9.99.

Subscribers, to change your email address please 
email us at subscriptions@editwell.com
with both your old and new email address.  
Allow 2 weeks for the address change to 
become effective.

Articles are written for Final Cut Studio 
version 5.0 or later, unless otherwise noted.

Edit Well is published monthly by Peachpit, the Creative Group of Pearson Education
1249 Eighth Street • Berkeley, CA 94710

Edit Well is an independent journal not affi liated with Apple Computer, Inc.  Apple, the Apple logo, Mac, 
and Macintosh are registered trademarks of Apple Computer, Inc.  All other trademarks are property 
of their respective holders.  Any trademarks mentioned in this issue are for editorial purposes only. 
Copyright © 2006, Peachpit, the Creative Group of Pearson Education.  All rights reserved. 

Write Us!
letters@editwell.com

EditWell
THE INTERACTIVE NEWSLETTER

FOR FINAL CUT STUDIO

4 | About our Writers

 6 | New Technologies at NAB Philip Hodgetts

 10 | Using Mattes and Masks in Final Cut Pro Kevin Monahan

 16 | Great 3rd Party Plug-insYou Never Heard Of Mark Spencer

 19 | Audio Interviews: Paul Saccone and Kym Rogers

 20 | Getting Great Results Using Compressor 2 Bruce Nazarian

 23 | Video Tutorial:Trouble-ShootingYour Final Cut Pro System

 24 | Introduction to Scopes Larry Jordan

 29 | Keyboard shortcuts

 30 | Why should you care about Auto Select? Tom Wolsky

In this issue

MAY 2006 | I SSUE 1

oming Next Issue:C



JUNE 2006  | 6

In this Issue:  Contents | Writers | NAB | Mattes | Plug-ins | Compression | Tutorial | Scopes | Shortcuts | Auto Select

EditWell

Here’s a quick update on the news of interest to 
Final Cut editors from the 2006 National Association 
of Broadcasters convention in Las Vegas. On the surface, 
this was a year without major announcements from 
Apple. However, under the surface three major trends 
were evident. First were new camera technologies, 
such as the RED camera. Second was a feeling that 
tapeless workfl ow, for all the unanswered questions, 
is starting to feel “real;” and third, related to tapeless 
workfl ow, is a rise in affordable digital asset 
management tools. 

New camera technologies
The only really signifi cant buzz around a single 

product this year involved the RED camera, a 
project backed by Jim Jannard of Oakley, Inc. fame, 
joined by noted Final Cut community personalities 
like Ted Schilowitz (formerly AJA’s Macintosh 
product manager), Graeme Nattress (Nattress 
Productions plug-ins ), and Frederic Haubrich 
(Lumière HD). While it’s an ambitious project to 
develop a ultra-high-resolution camera with a 
planned price of $17,500 for the basic camera body, 
the team behind the camera makes it believable. 
But, RED wasn’t alone.

Silicon Imaging was showing a prototype, with 
images, of their new “cinema class” 1920 x 1080 

camera. Like RED, this camera uses a CMOS-based 
imager and is designed to work with standard cinema 
lenses. Silicon Imaging is targeting 16mm PL-mount 
lenses, while RED is planning to support Super35 mm 
PL-mount lenses. The third offering, from Colorspace, 
is also positioning itself as a fi lm-camera replacement, 
with both 35mm and 16mm equivalent offerings.

What these cameras have in common is imaging 
quality similar to that of the Dalsa/CineAlta/Viper, 
but at prices that make them affordable for mere 
mortals.  All are targeting sub-$30,000 pricing, 
depending on accessories. 

This trend toward CMOS means that we need to 
rethink what we know about camera technology. 
First, these are single CMOS chips with Bayer Pattern 
fi ltering. This is the method that single-CCD chips 
use to derive color from a single sensing device, and 
has been considered to offer inferior color quality 
to three-CCD cameras. It’s time to rethink that idea.

Neither the CMOS nor the CCD technologies are 
inherently superior. Both types were developed in 
the late ’60s and early ’70s, often by the same 
developers. CCD technologies have dominated 
because they were easier and cheaper to fabricate than 
CMOS. These days, advances in silicon technology 
have benefi ted CMOS, which has found growing 

Three trends at NAB: 

new camera
technologies

tapeless 
workfl ow

digital asset
management

By Philip Hodgetts

NAB 2006: The News You Need to Know
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application in digital still cameras and now in this new 
class of digital-cinema cameras. CMOS imagers are 
more complex to fabricate, but generally require fewer 
supporting components and less power than CCDs.

We’ll also have to get used to working with much 
larger fi le sizes and images from larger sensors. Using 
images from large sensors is defi nitely a positive 
move – bigger is better for imaging – and larger fi le 
sizes have been coming 
for some time. 

The third implication of 
new camera formats, for 
both these large-scale 
CMOS digital-cinema 
replacements and the 
more common sources 
such as Panasonic’s 
HVX-200, is an explosion 
of formats: frame size and 
frame rate combinations that threaten to over-
whelm us with fl exibility. The HVX-200 alone has 
nearly 100 image size and frame rate combinations! 
The RED camera will support an almost infi nite 
combination of frame size and frame rate. Gone 
forever is the simplicity of one-size-fi ts-all Beta SP 
or even Digital Betacam. Gone, too, is the idea that 
every editing package will be able to edit every 
video format. Staying current becomes even more 
critical as more and more formats are released.

In the future, we’ll have to carefully consider the 

most appropriate combination of quality and cost, 
of frame rate and frame size, that suits the project 
at hand.  And then test, test, and test the workfl ow 
until (we hope) some later date shows us time-
tested workfl ows.

Tapeless workfl ow
One thing is for certain: These new cameras will 

not be recording to good old videotape.

For example, Panasonic 
extended the range of its 
P2-based devices this year; 
Sony showcased its tapeless 
XDCAM and XDCAM HD; 
Grass Valley presented its 
Iomega-sourced Infi nity 
cameras; Canon supported 
the Wafi an drive for its XL 
H1 camera; and Hitachi 

combined its Mediapac Flash 
RAM and hard-drive based cameras. The age of tapeless 
workfl ow is upon us, and undoubtedly we will get 
used to tapeless or “IT-centric” workfl ows in time. 

“IT-centric workfl ow” simply treats video, audio, 
and timecode data as digital bits (which they certainly 
are), and stores, manipulates, and manages these 
bits using the same technologies that have driven 
IT departments in large corporations over the last 
decade. The problem is, most post-production facilities 
don’t have huge IT departments, and aren’t adept 
at treating video and audio as data.

New Technologies continued

The biggest problem 
with tapeless workfl ow 
is archival storage.
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Compounding the situation right now is a 
complete absence of established workfl ows 
and archive solutions. In fact, of all the 
tapeless acquisition formats, only Sony’s 
Blu-ray optical-media based XDCAM and 
XDCAM HD have any form of archiveable 
source media. These discs are like tape in 
that they can be archived or reused, and 
have a price comparable to that of tape. 
The other formats for acquisition use 
short-term storage to transfer the data into 
edit storage and then to some unspecifi ed 
long-term storage.

The biggest problem presented by tapeless 
workfl ow is archival storage. Tape works as 
both source and archive, but in a tapeless 
future the acquisition medium will not be 
the storage archive (except, perhaps, for 
XDCAM/XDCAM HD). Unfortunately, no 
one was showing the perfect video archive 
solution at this NAB, and chances are that 
they won’t have it ready next year, either. 
On the positive side, IT departments are 
experienced in storing massive amounts of 
data every day, so the fault-tolerant RAID 
storage solutions and tape-based archive 
solutions present in that world are likely to 
fi lter down to the video world and present 
us with the fi rst solutions. 

 At NAB, Quantum was 
showing an IT-based tape archiving 
solution for about $8,000, and Rimage 
was showing an optical-media archiving 
solution for about $5,000. Both were 
Macintosh-based.

It’s important to note that simply archiving 
to a single drive doesn’t mean that you 
have a safe backup.  All hard drives will fail 
eventually, and prudence requires that we 
use fault-tolerant RAID 3 or RAID 5 storage, 
or have a minimum of two copies of data 
on two drives in two locations.

Looking forward a little, archive solutions 
based on Blu-ray or HD DVD optical media 
may be available by next year at reasonable 
prices; casting our vision a little further out, 
holographic storage may be the solution we’re 
seeking. This year, Fujifi lm was showing a 
3.9TB variant of the Holographic Versatile 
Disc. (Separating “HDV” and “HVD” will 
certainly be confusing!) 

Fuji was one of the partners in the HVD 
Alliance, building on technology originally 
developed by Optware, which also partnered 
with Toshiba this year. With storage capacity 
to spare and transfer speeds up to 40 times 
that of current DVDs (meaning about 

Editor’s No
te:

Apple Computer
www.apple.com

Avid Interplay
www.avid.com/company/releases/ 2006/
060423_interplay_avid.html

Colorspace
www.colorspaceinc.com/

Hitachi
www.hitachikokusai.us/

InPhase Technologies
www.inphase-technologies.com/

Panasonic
www.panasonic.com/business/provideo/home.asp

Proximity Corporation 
www.proximitygroup.com/

Quantum Corporation
www.quantum.com

RED Camera
www.red.com/

Rimage Corporation
www.rimage.com

Silicon Imaging
www.siliconimaging.com/DigitalCinema/

Sony
bssc.sel.sony.com/BroadcastandBusiness/index.shtml

New Technologies continued Links mentioned in this article

http://www.apple.com
http://www.avid.com/company/releases/2006/060423_interplay_avid.html
http://www.colorspaceinc.com
http://www.hitachikokusai.us/
http://www.inphase-technologies.com/
http://www.panasonic.com/business/provideo/home.asp
http://www.proximitygroup.com
http://www.quantum.com
http://www.red.com
http://www.rimage.com
http://www.siliconimaging.com/DigitalCinema/
http://bssc.sel.sony.com/BroadcastandBusiness/index.shtml


JUNE 2006  | 9

In this Issue:  Contents | Writers | NAB | Mattes | Plug-ins | Compression | Tutorial | Scopes | Shortcuts | Auto Select

EditWell

35–40MB/second), holographic technology 
could meet the needs of archival storage. 
The HVD is physically compatible with current 
DVD discs, so an upgrade path exists.

As in the Blu-ray vs. HD DVD battle, 
there is a competing offering. Maxell joined 
with holographic pioneer InPhase with a 
30GB storage capacity drive, scheduled for 
release late in 2006. However, Maxell and 
InPhase’s drive offers only a fraction of the 
storage capacity of HVD and a slower 
transfer rate of 20MB/sec.

Until either technology matures, protected 
RAID storage looks to be the most effective 
way to archive in a tapeless environment. 
Longer term… well, check back after the 
next NAB.

Digital asset management
Massive digital media archives present 

another problem: how to fi nd fi les you need. 
Tape archives present their own access 
problems, but with multiple terabytes of 
data stored in even the smallest facility, 
over time, fi nding assets brings us to the 
fi nal overarching theme at NAB 2006: 
digital asset management (DAM).  As in 
“DAM(n)! Where did I put that fi le? I’d 
better fi nd it or my asset is on the line!”

Asset management is going to become one 
of the most critical technologies in the 
tapeless workfl ow of the future.

DAM was a large part of the Avid Interplay 
story at NAB.  A hybrid of shared media, 
asset management, workfl ow automation, 
and security control in a single system, 
Interplay currently suits only large facilities 
because it’s built on Avid’s Unity as a platform. 
Neither Apple nor Adobe had a new offering 
in digital asset management to match Avid.  
Apple was actively promoting Proximity’s 
“artbox” for Final Cut Studio, and building 
on Xsan. Like Interplay, artbox provides 
collaborative access to assets (resolution-
independent) and tight integration with the 
editing engine. artbox is relatively expensive, 
starting around $25,000, although this is 
still less expensive than Interplay.

NAB 2006 showed that the proven 
technologies and workfl ows we’ve enjoyed 
are at an end, as is SD. Instead, we have a 
future with an almost infi nite choice of 
frame size, frame rate, and acquisition 
media. As always, we still have to balance 
between quality and cost. How the media 
is stored and how it’s found after being 
archived are relatively new problems still 
to be solved defi nitively.

New Technologies continued

If you’re a Final Cut Pro 5 user, you may 
be deciding whether to upgrade to version 
5.1, especially as it costs money.

Paul Saccone, product marketing manager 
for Final Cut Studio, and Brian Meaney, 
product designer for Final Cut Studio, 
suggested several reasons to upgrade:

• Intel/Mac support

• Signifi cant performance and speed 
improvements to Compressor

• Bug fi xes and support 
for new video formats

• Tighter integration between 
FCP and Motion

• Very cost-effective way to upgrade 
from a single earlier application to 
the entire product suite

Click to hear an audio interview with 
Paul Saccone discussing the benefi ts of the 
5.1 upgrade.

Why upgrade to 
Final Cut Studio 5.1?

http://www.peachpit.com/content/downloads/peachpit/editwell/ew01_saccone.mov
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At the very heart of video effects creation, you’ll 
fi nd masks and mattes. Masks and mattes give you 
the power to shape and blend clips to form wholly 
new images, more commonly known as composites.

Mattes vs. masks
You may be wondering, “What’s the difference 

between a matte and a mask?” The answer is “Not 
much.” Mattes and masks both have the same effect: 
They create and control the areas of transparency in 
a clip. But there are two crucial differences between 
these two features:

A matte is most commonly a fi lter that controls areas 
of transparency within a clip. These fi lters defi ne areas 
of transparency with parameters such as sliders and 
point controls. You activate mattes with Effects > 
Video Filters > Mattes. Use mattes if you need a 
fi lter with a simple shape.

A mask is an independent graphic or video clip 
(usually grayscale) lying on a video track between 
the foreground and background images. The mask 
serves the same purpose as a matte. To “unlock” this 
mask, you must use a composite mode such as Travel 
Matte Luma or Travel Matte Alpha. You can use a mask 
to create a more custom look than you can get with a 
matte, which has predefi ned parameters. (See Figure 1)

Matte fi lters at a glance
FCP has six fi lters that you 

can use to create mattes: 

Garbage Matte.  Allows you 
to create shaped mattes by 
manipulating point controls. 
There are both four- and eight-point varieties, 
which are useful for cutting out oddly shaped items.

Extract. Takes the luma information of a clip and 
allows you to use it as a Travel Matte Alpha or 
Travel Matte Luma mask.

Image Mask. Works like a mask fi lter, in that you 
need to supply a separate mask image to make 
the blend.

Mask Shape. Provides basic matte shapes such as 
rectangle, rounded rectangle, diamond, and oval.

Widescreen. Used to simulate a widescreen effect 
with an adjustable viewing area.

Soft Edges. Makes a blended matte with built-in 
feathering, perfect for a vignette effect with 
edges that fade to the frame’s border. 

Now that you’re familiar with the major players 
in matte creation, let’s see how mattes create 
blended video imagery.

Great Visual Effects
 Using Mattes and Masks

Figure 1: This image is a composite 
made from two separate images. 
The foreground image (the woman) 
uses a shape mask and a Mask 
Feather fi lter. The clip has also 
been fl opped, repositioned, and 
tinted.

By Kevin Monahan
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Mattes, masks, and the alpha channel
You probably already know that the colors 

of digital video are created with a combination 
of red, green, and blue pixels. The red, green, 
and blue channels control the level at which 
each pixel displays. Each pixel also has the 
power to be transparent or opaque (solid). 
The channel that determines transparency is 
called the alpha channel. The alpha channel 
uses grayscale values to control whether a 
pixel is transparent, semi-opaque, or opaque.

When you’re manipulating a matte or mask, 
you’re actually controlling the alpha channel 
of a clip. Three values determine the areas 
of a clip: 

•Black (fully transparent)
•Gray (semi-transparent)
•White (fully opaque)

See the alpha channel in action by doing 
the following:

1. Load a clip into the Viewer. 
2. Change the View pop-up menu in the 

Viewer to Alpha. (Figure 2)
3. Your Viewer will now be white, repre-

senting the clip’s full opacity. (By default, 
a clip’s alpha channel is 100% white.)

4. Choose Effects > Video Filters > 
Matte > Mask Shape. 

Mattes & Masks continued

Figure 2: Select Alpha to view clip transparency.

Figure 3: Black represents 100% opacity in Alpha 
view. Notice that the alpha channel changes to a white 
rectangle on a black fi eld. Black in this view represents 
an area of full transparency.

Figure 4: Viewing black text and effects is easy when 
the background is changed to Checkerboard 1.

Figure 5: By switching to RGB view, you can easily see 
how the alpha channel operates. Notice that the area 
that was black in Alpha view is now transparent, indicated 
by the checkerboard background. The alpha channel 
controls the transparency of each pixel in the clip.
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5. Change the View pop-up menu to RGB and the 
background to Checkerboard 1 (see Figure 4).

Using mattes
Now that you know what’s going on behind the 

scenes, you can create a simple blending technique 
by putting a matte fi lter into practice:

1. Place a clip on V1 in the Timeline.
2. Edit a different clip on V2 directly above the V1 clip.
3. Double-click the V2 clip, loading it into the Viewer. 
4. Choose Effects > Video Filters > Matte > 

Mask Shape.
5. Experiment with the fi lter’s parameters on the 

Filters tab and watch what happens (see Figure 6).
You should now see a composite, which displays 

both the foreground image (defined by the 

transparency created by the matte) and background 
image at the same time. By changing the parameters, 
you can alter the shape and/or the position of the 
matte. Keep in mind that you can also reposition, 
scale, rotate, distort, or add a fi lter to the affected clip. 

To avoid blurring when repositioning an image 
using interlaced video, be sure its vertical posi-
tion on the Canvas is set to an even whole 
number. Set this in the Motion tab by adjusting 
the right-hand box in Basic Motion > Center.

Available masks in FCP
Where can you fi nd masks in FCP? Actually, 

you can use generators such as Custom Gradient, 
Highlight, Particle Noise, Shapes, Boris Vector Shape, 
or even Title 3D to create a grayscale mask. You 

Mattes & Masks continued

Figure 6: The foreground clip’s matte is repositioned and hori-
zontally scaled. The clip is also repositioned and tinted.

Figure 7: This Circle generator has the Wave fi lter added to 
itwdding fi lters to generators is a creative way to make grayscale 
mattes within FCP.

Tip:
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Note:

can spice up the look of the generators with the 
addition of a fi lter (see Figure 7), or stack two 
generators and apply a composite mode (Hard 
Light, Overlay, etc.) to the overlying clip, and then 
nest the two into a single graphics track. I’ve com-
bined fi lters and composite modes for cool masks 
inside FCP.  You can even create more complex 
static masks in Adobe Photoshop.

Mask techniques
We’ve already seen how to use mattes, so what’s 

the technique for blending images using a mask? 

1. Stack two clips on separate video tracks, placing 
the foreground clip on V3 and the background 
clip on V1.

2. Place the grayscale generator of your choice on 
V2 between the edit points of the V3 and V1 clips.

3. Select the V3 clip. Choose Modify > Composite 
Modes > Travel Matte Luma. (You can also change 
a composite mode by Control-clicking the clip and 
choosing the desired mode from the shortcut 
menu.) Figure 8 shows my result.

4. Make any necessary adjustments to the 
grayscale matte clip.
 The stacking order of the clips is important 

– background on V1, mask on V2, and foreground 
on V3.  A common error occurs in applying the 
composite mode; you must apply it to the V3 clip 
(also called graphic fi ll), not to the mask itself.

Travel Matte Luma vs. Travel Matte Alpha
You may wonder when it’s better to use one fl avor 

of travel matte versus another. Here’s the general 
rule:  When a mask element has an embedded alpha 
channel, such as a Title Generator, Title 3D, or Boris 
Vector Shape, it’s better to use Travel Matte Alpha. 
This mask is much cleaner than Travel Matte Luma. 

For example, it’s possible to create a black-and-
white text generator for a mask element on V2 and 
apply the Travel Matte Luma composite mode to a 
clip on V3 for a simple “video in text” effect. If you 
use Travel Matte Alpha, however, the edges of the 
text will be sharper.

Figure 8: A Circle generator with the Wave fi lter applied serves 
as the V2 matte in this composite. The matte’s edges undulate, 
as the Wave fi lter is self-animating.

Mattes & Masks continued

Trivia Bin
The alpha channel 

(along with other 

computer graphics 

milestones) was 

invented by the 

Lucasfi lm Computer 

Division in the late 

1970s. 
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Animated mattes and masks
Mattes and masks don’t necessarily have to remain 

static. Matte parameters can be animated with 
keyframes. Masks can be created with animated 
grayscale values. Doing either creates an “undulating” 
blended effect that you can use to create further 
custom effects. FCP generators combined with 
animated fi lters offer some interesting possibilities. 

To readjust a point’s position in a Garbage 
Matte or the position of a Shape Mask, return 
to the Filters tab and click the point control’s 
button (the cross-hair) to reset it before moving 
it in the Canvas. Otherwise, you might nudge the 
entire image.

Feather and choker fi lters
Mask Feather and Matte Choker are two more 

fi lters in FCP’s collection of matte fi lters. They aren’t 
actually mattes or masks themselves, but tools to 
control the edges of the mattes. These fi lters add 
and subtract grayscale values from the boundary of 
the alpha channel, each in a slightly different way:

Mask Feather.  Add this fi lter just below any 
matte fi lter in the Filters tab to soften the edges 
surrounding your clip or graphic. This technique 
lends a vignette effect to any image by adding a 
gradient ramp at the edges of the alpha channel.  
Almost every graphic will need at least a little 
feathering; just make sure that Mask Feather lies 
at the bottom of the fi lter stack.

Matte Choker.  Add this fi lter just below any matte 
fi lter in the Filters tab, and you can subtly expand 
and contract the edges of the clip or graphics. 
This effect is achieved by adding or subtracting 
solid black or white to the edges of the graphic. 

A matte choker is most commonly used to 
reduce, or “choke,” the matte derived from a 
chroma key.

Compositing technique: blurry border
Here’s a simple technique to add a blurry border 

to an image:  

1. Shift-Option-drag the V1 clip upward to place 
an identical copy of the clip in the track above.

2. Turn off the visibility of the V1 clip by Control-
clicking the clip and choosing Clip Enable from 
the shortcut menu (or press Control-B).

3. Apply a matte fi lter to the V2 clip; for example, 
Effects > Matte > Mask Shape. Try a few 
different shapes from the Shapes pull-down 
menu.  Adjust the parameters as you see fi t.

4. Add a Mask Feather fi lter to soften the edges.
5. Turn on the visibility of the V1 clip by Control-

clicking the clip and choosing Clip Enable from 
the shortcut menu again (or press Control-B).

6. Apply a Gaussian Blur fi lter to the V1 clip 
(see Figure 9).

Tip:

Mattes & Masks continued

Tip:
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The clip appears to have a blurry border, 
but what’s really going on is that the two 
images have been altered by a matte on V2 
and a Blur fi lter on V1.

A different look can be achieved in a 
similar way by using a color correction 
or tint applied to either or both clips.

Video-in-text effect
A simple video-in-text effect has the ability 

to send two messages at once: a written one 
and a visual one. Everyone should know how 
to make the following effect: 

1. Place the clip you want to use 
as the background on V1.

2. Place the text generator you want to 

use on V2. (I prefer Title 3D and 
LiveType over the standard Final Cut 
text generators.)

3. Place the video you want to see 
within the text on V3.

4. Select the V3 clip.
5. Choose Modify > Composite Modes > 

Travel Matte Alpha.  You should now see 
your video within the matte created 
by the alpha channel from the text 
generator.  Add a drop shadow to the 
video in text. This is normally impossible 
to do because a drop shadow needs to 
use the “graphic fi ll,” but is already being 
used by the V3 clip. You can get around 
this restriction by nesting the clips.

6. Select the clips on V2 and V3.

7. Nest them by selecting Sequence > 
Nest Items (Option-C).

8. Name the nest “Video in Text” and click 
OK. The clips collapse into a nest.

9. Option-double-click the nest to load 
it into the Viewer.

10. On the Motion tab, click the checkbox for 
Drop Shadow and adjust its parameters 
to get the look you want (see Figure 10).

 My favorite drop shadow 
settings are: Offset 1.5, Angle 135, 
Softness 30, Opacity 90. 

You now have a pretty video-in-text effect 
that was created with the letters of the 
generator acting as mattes in a Travel Matte 
Alpha effect. Experiment with the different 
elements (such as animating the type or color 
correcting the graphic fi ll), if you like. You’ll 
soon have some professional looks going on.

There are literally endless things you can 
do with mattes, masks, and the techniques 
with which to exploit them. This article 
discussed only three layers of images, but 
FCP has 99 video tracks available, and nesting 
increases that number to an astronomical 
amount. Keep stacking those layers of video 
and graphics and let your imagination run 
free. 

Figure 10: To add a drop shadow to the effect, nest 
the travel matte effect fi rst.

Figure 9: Achieve a blurry border effect by stacking 
identical images and applying a matte to the upper 
layer and a Blur fi lter to the lower layer for a simple 
and elegant look.

Tip:

Mattes & Masks continued

Editor’s No
te:
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Part one of a two-part article!

Final Cut Pro ships with 60 video transitions, 
almost 90 video fi lters, and 26 generators, 
but sometimes they just aren’t enough to 
give you the specifi c look you want. Whether 
you want a different kind of transition, or 
you’re going for a “fi lm look,” trying to pull 
a great green-screen key on some less-than-
perfect footage, or otherwise manipulating 
your image, there’s probably a solution out 
there for you. 

Thanks to Final Cut’s built-in FXScript 
effects language and a large community of 
Final Cut users and developers, a plethora 
of third-party plug-ins are available — the 
hard part is trying to sift through all the 
options to determine what’s right for your 
needs and budget. So here’s a two-part guided 
tour through some of the colorful jungle of 
third-party plug-ins for Final Cut Pro. In this 
issue, I’ll discuss the free plug-ins. Next month, 
I’ll present those that cost money.

So what is a plug-in, anyway?
A third-party plug-in is usually a bit of code 

written in FXScript that, when added to 
Final Cut Pro (see sidebar, Installing Plug-ins), 

appears as a brand new fi lter, transition, or 
generator in the Effects tab of the Browser. 
It can also be a full-blown application that 
“lives” inside Final Cut as a fi lter but has its 
own interface.

Free plug-ins every editor should have
Our fi rst stop in the plug-in jungle is the 

free plug-in swamp — these are some of 
the free fi lters available for download that 
are worth looking over.

The free Too Much Too Soon (TMTS) 
fi lters from Mattias Sandström have been 
around since the early days of Final Cut Pro; 
there were 18 of them as of the time of 
writing. You get a mix of fi lters, transitions, and 
generators — check out the Clock generator 
if you need a digital clock, for example (see 
Figure 1). The Flashframe and the Wind 

Blur/Cross transitions are interesting as 
well. There are a bunch more technically 
oriented fi lters for deinterlacing footage, 
removing scratches, chroma resampling, 
and anamorphic squeezing.

Another venerable old-timer to FCP is the 
Eureka! plug-ins. The free package contains 6 
fi lters, 2 text generators, and a nice transition 
called Vapor Across.

Next up are Stib’s free plug-ins, all recently 
updated for Final Cut Pro 5. You get 8 
transitions, 13 fi lters, and 7 generators. The 
Star and Arrow generators are useful for 

Surviving the Jungle of 3rd Party Plug-ins

By Mark Spencer

Figure 1: The Clock generator from TMTS plus the 
OCR font = instant digital clock.

Figure 2: The results of using Stib’s Star generator 2.0.
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quickly creating those shapes without going into another application 
(see Figure 2).

Want to create a vignette effect but you’re frustrated using shapes, 
masks, and composite modes? Download Marcus Herrick’s free 
vignette plug-in. You’ll also get his Facelight plug-in. 

Have a bunch of subtitles in Final Cut Pro that you want to get 
into DVD Studio Pro? No problem with Spherico’s TitleExchange.  
A big time-saver, and the Lite version is completely free.

Looking to create a “fi lm look” on your video footage, but don’t 
have any budget for a more full-featured plug-in? Consider Perfectly 
Polite Pictures’ Quick.Look, which is currently in prerelease and there-
fore available for free. For other “fi lm look” options, be sure to check 
out Film Effects and Magic Bullet for Editors, discussed below.

River Rock Studios offers three free plug-ins: Jitterbug, Chromatic 
Glow, and Day for Night.

At Lyric Media is a neat free plug-in called Shadow-Highlight that 
lets you open up shadows and reduce highlights à la the tool of 
the same name in Photoshop.

Feel restricted by Final Cut’s lowly eight-point garbage matte? 
Tom Henderson hears your pain — and comes to the rescue with 
a 50-point Bezier Matte that allows for curves between points — 
and it’s free.

Adam Wilt has created two plug-ins for blurring and offsetting 
chroma information. H. Chroma Blur is useful for footage that will 
be keyed; Chroma Offset is handy for correcting Y/C delay errors 
in analog footage.

All Final Cut Pro plug-ins are placed in the same location: 

/Library/Application Support/Final Cut Pro System 
Support/Plugins

That’s the Library of your root drive, not your user Library. 

You’ll need to quit and relaunch Final Cut in order to have 
access to your new plug-ins. To apply them, either go to the 
Effects tab of the Browser or to the Effects menu. Some 
third-party plug-ins create their own new folders; others are 
placed into an existing effects category: fi lters, transitions, 
generators. 

Where to put them and where to fi nd them

ABOVE: Some third-party plug-ins, 
such as Eureka!, use custom folders. 

RIGHT: Some plug-ins, such as Face 
Light or Vignette, are placed into 
the appropriate existing folders.

Third-Party Plug-ins continued

INSTALLING PLUG-INS
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Final Cut Pro FREE plug-ins

Manufacturer Plug-in

Mattias Sandström Too Much Too Soon

Kafwang Eureka!

Stephen Dixon Stib’s free plug-ins

Marcus Herrick vignette, Facelight

Spherico TitleExchange Lite, Shifter, 
FCP Record Timer, SyncTime

Perfectly Polite 
Pictures Quick.Look

River Rock Studios Jitterbug, Chromatic Glow, Day for Night

Lyric Media Shadow-Highlight

Tom Henderson 50-point Bezier Matte

Adam Wilt H. Chroma Blur, Chroma Offset

CGM FXScript DVEs

Patrick Sheffi eld Two-strip and three-strip Technicolor 

If you’ve been using Final 
Cut for awhile, you may be 
familiar with CGM’s FX-
Script DVEs — a package 
of fi lters, transitions, and 
generators that shipped 
with FCP 3 (see Figure 3). 
If they’re not installed with 
your current version of Final 
Cut, dig up your FCP 3 install 
disk and get them in there — 
the transitions in particular 

are quite nice. If you don’t have FCP 3, you can buy any of CGM’s 
fi lters, discussed below.

With many of the free plug-in packages, you may fi nd some that 
are useful and some that don’t quite live up to your expectations. 
But don’t throw the baby out with the bathwater — there are usually at 
least a few useful fi lters in each of the bundles above.   As with anything 
that’s free, instructions can be sparse to nonexistent, and not every 
plug-in is updated to work with the latest version of Final Cut Pro, 
so test each one before you have your heart set on building your 
whole project around it. Finally, if you get a lot of mileage from some 
of these free plug-ins and the vendor has other plug-ins for sale, 
consider checking out the paid versions — that support keeps the 
free stuff coming!

Free plug-ins are great — but they get you only so far.  Next month, 
we move deeper into the plug-in jungle and discover a wide variety 
of incredible effects from plug-ins; all of which are less than $200. 

Next month:  Great 3rd Party Plug-ins continues, plus Creating Your 
Own Effects with FX Script.

Figure 3: CGM’s FXScript DVE fl ip transition.

Third-Party Plug-ins continued

Click manufacturer’s name to browse to their site

http://mattias.nu/plugins/
http://www.kafwang.com/eureka/eurekamain.html
http://fxscript.org/plugins.html
http://www.haiku.com.au/2005/08/final-cut-pro-plug-ins.html
http://www.spherico.de/filmtools/TitleExchange/
http://www.perfectlypolitepictures.com/presents/quicklook
http://www.riverrockstudios.com/riverrock/pages/FCP.html
http://www.lyric.com/fcp-plugins/index.htm
http://homepage.mac.com/tomhenderson/beziermatte/
http://www.adamwilt.com/SteppyEdges.html
http://www.cgm-online.com/eiperle/cgm_e.html
http://www.pistolerapost.com/tech/2strip.html


While Compressor can convert between 
NTSC and PAL video, calling it extremely slow 
would be a compliment.  A much better utility is 
Standards Conversion (version 2.5), published 
by Nattress Productions (www.nattress.com).

This plug-in contains six modules: 
 • G Standards Converter
 • G Film Converter
 • G Advanced Pulldown Converter
 • G Add Pulldown
 • G Remove Pulldown
 • G Map Frames
The Standards Conversion package 

contains two fi lters that have been 
designed to convert among the three 
video standards: NTSC video (29.97 
frames per second), PAL video (25 frames 
per second), and 24p (24 frames per 
second progressive). 

In addition, this toolkit contains other 
useful fi lters that work in a manner 
similar to that of the main fi lters. 
G Remove Pulldown and G Add Pull-
down allow you to add and remove 

pull-down frames from the timeline. G Map 
Frames enables you to manipulate frames and 
fi elds, as well as produce nice slow-mo from 
interlaced footage. G Advanced Pulldown 
Converter can be used if you’ve shot the 
wrong mode; for example, on a Panasonic 
DVX100.

This plug-in works best on individual clips, 
rather than complete sequences. Recommended 
for FCP 5 and later. Retail price $100 (US).

Converting NTSC, PAL, and Film Formats

Sample fi lter settings for G_Conversion to convert NTSC 
video to PAL.

Listen to Apple’s product marketing 
manager for Final Cut Studio explain 
how Apple balances the needs of the 
market and Final Cut users; as well as 
a system to report bugs.  (TRT: 11:52)

Paul Saccone Interview

Audio Exclusive

Final Cut Studio is a world-wide 
phenomenon. Listen to Kym Rogers, 
Pro AV Dealer in Adelaide, Australia, 
about some unusual uses of Final Cut 
in the world “down under.” (TRT 7:30)

Kym Rogers Interview

click 
to 
play

click 
to 
play
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http://www.peachpit.com/content/downloads/peachpit/editwell/ew01_saccone.mov
http://www.peachpit.com/content/downloads/peachpit/editwell/ew01_rogers.mov
http://www.nattress.com


JUNE 2006  | 20

In this Issue:  Contents | Writers | NAB | Mattes | Plug-ins | Compression | Tutorial | Scopes | Shortcuts | Auto Select

EditWell

Note:

Note:

One of the most mysterious techniques in DVD 
creation is the “black art” of video compression. 
For those who are new to DVD, and have had no 
prior experience with video compression, making 
great video for a DVD can seem a daunting task. 
In reality, though, some pretty simple rules can get 
you launched on the right path to success. We’ll cover 
a few of those rules in this article:

1. Know the encoding “sweet spots.”
2. Make a “bit budget.”
3. Use the right source fi le.
4. Use the right MPEG format.
5. Edit the content properly.
6. Set chapter markers in FCP or Compressor 

before encoding.
Know the encoding “sweet spots”

MPEG-2 encoding doesn’t have a linear relationship 
between the encoding bitrate used and the quality 
of the fi nished bitstream. Typical average DVD encode 
bitrates are between 4.5 and 8 Mbps, depending on 
the length of the content. With encode rates at or 
below 3 Mbps, it’s diffi cult to get a satisfactory-quality 
bitstream with any encoder, let alone Compressor. 
(The optical image fl ow analysis in Compressor 2 
should provide better results in general, but it takes 
a lot longer to compress.)

 Bitrate as used here means the average 
encoding rates set for the MPEG encoder; 
bitrates are always specifi ed in megabits per 
second (Mbps). Encoding means compressing 
your audio or video elements so that they can 
be played on a video DVD. 

Likewise, encode rates above 6 Mbps may not be 
needed, as most content can be encoded at or below 
that rate. I typically quote three encode rates as 
general benchmarks:

• An average bitrate of 4.5 Mbps fi ts about 
120–130 minutes on a DVD-5. 

• An average bitrate of 6 Mbps fi ts about 
90 minutes of content. 

• Content of 60 minutes and under can 
use video bitrates of up to 8 Mbps. 

Rates higher than 8 Mbps are tempting because 
of the perception of higher quality, but can cause 
diffi culties in playback in some DVD players. 

 All these rates assume that you’re using 
Dolby Digital stereo (AC3) at 192 Kbps.

Be wary of using PCM (AIFF) audio fi les, which 
can gobble up DVD storage space and 1.6 Mbps of 
your data bandwidth, reducing your video encoding 
rates accordingly.  AIFF fi les also don’t allow you to 

Getting Great Results Using Compressor 2

If you’ve been frustrated 
by the video quality of 
Compressor 2, consider 
upgrading to Final Cut 
Studio 5.1.  According to 
Paul Saccone, Final Cut 
Studio’s product marketing 
manager, the latest version 
of Compressor (v2.1) has 
been signifi cantly reworked 
for both performance and 
quality. Paul says they have 
specifi cally fi xed a number 
of bugs related to VBR 
compression.

This feature alone might 
justify upgrading to 5.1.

Compressor 
UpgradeBy Bruce Nazarian, “the DVD Guy”
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create 5.1 surround sound programs, while Dolby 
Digital does.

Make a “bit budget”
Avoid guesswork when calculating the encoding 

rates needed for your video and audio streams. 
Making a “bit budget” will verify that you’ve allocated 
suffi cient space on the disc, and determined the proper 
average and maximum video encode rates correctly 
before encoding.   Average bitrate is used in all encoding 
setups, while the maximum bitrate is used only in 
variable bit rate (VBR) encoding, which we cover later.

Your bit budget helps you use the size of your DVD 
to determine the encode bitrate based upon the total 
running time of your video, audio, and subtitle streams, 
as well as motion menu content. The end result is 
confi dence that you have properly specifi ed the encode 
rates for your video, and your encoded streams will all 
really fi t on your DVD. 

Since bit budgeting involves a lot of messy mathematics, 
a bit budget tool can help you to determine the proper 
results faster, and with fewer errors. Download a 
free “Make a Bit Budget” Excel worksheet from my 
web site. Just sign up for our Yahoo! Group and the 
worksheet is yours.

Use the right source fi le
MPEG-2 is a lossy compression format, and good 

quality results are very dependent on having the highest-
quality master possible. This may seem a simple idea 
to grasp, but I’m continually amazed at the number of 
video professionals who try to make great-looking 

DVDs from inferior sources or from 
previously compressed fi les. 

While the DV codec is great for 
casual shooting, it’s not a great choice 
for advanced things like titles and 
graphics. Choosing and using a better 
codec will give your MPEG-2 video 
a fi ghting chance of emerging from 
the encode process unscathed. If you 
can capture uncompressed 8-bit (or 
even Photo JPEG or Motion JPEG) 
and encode from there, you’re likely 
to have better results with titles and 
graphics. If not, up-converting the DV 
content to a better codec (such as 
uncompressed 8-bit) while editing 
will give you better MPEG-2 results.

Use the right MPEG format
While you can use MPEG-1 for 

your DVDs, and in some cases benefi t 
from the additional running length 
available without too much of a 
quality compromise, MPEG-2 is far 
and away the most desired format. 
MPEG-2 has many formats, though, and sometimes 
making sense out of them can be confusing. Let’s 
sort them out.

CBR—One-pass constant bit rate (CBR) encoding 
is convenient and fast, but doesn’t always allow 
the highest-quality fi nished product at lower 

Figure 1

Compressor continued
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bitrates. If your program run time is less than 60 
minutes, you likely don’t need to lower the encoding 
bitrate low enough to make a difference. But a 
CBR encode can’t change the bitrate to match the 
complexity of the picture as it varies. Sometimes, 
this capability makes a difference! 

VBR—Variable bit rate (VBR) encoding formats are 
great. In theory, VBR encodes can extract greater 
quality from the source fi les than CBR can provide. 
Compressor offers a number of VBR encoding 
formats, both one-pass and two-pass. One-pass 
VBR is good, but two-pass VBR lends better 
image analysis and greater quality.

 Unfortunately, Compressor 2 seems to 
have some VBR encoding bugs that surface as 
undesirable motion artifacts on dissolves and 
fades. While the advantages of VBR are preferred, 
using CBR is a better choice until these bugs have 
been worked out. You’ll still get a great encode 
by using CBR. (See the sidebar Compressor Upgrade.)

In general, VBR works best on longer encodes 
(greater than 30 minutes), where it has the chance to 
actually optimize the encode. Shorter encodes don’t 
provide this opportunity to optimize, so the extra 
processing power is wasted.

Elementary versus multiplexed streams
While Compressor allows you to create an MPEG-2 

multiplexed fi le (called a program, transport, or 
system stream), where audio and video are inter-
leaved, this is not what you want for DVD authoring. 

Multiplexed streams are used for certain video 
LAN or broadcast applications. Individual fi les 
containing just MPEG video or just Dolby Digital 
or PCM audio are mandatory for DVD. 

If you use the DVD presets in Compressor, your 
movie fi les are automatically separated into these 
individual “elementary” video and audio streams 
during the encode process. 

Edit the content properly
If you’re creating a long-form video and hope to 

use segments of the video individually, it’s always 
best to edit the video properly with fades to and 
from black between the segments. These fade 
sections (containing a minimum of one second of 
black) provide the ability to place chapter markers 
between the segments, allowing for clean navigation. 
This is especially valuable if you’re planning on using 
stories in DVD Studio Pro to defi ne the segment 
beginnings and endings.

Set chapter points in FCP or Compressor 
before encoding
MPEG-2 groups individual frames into a group of 
pictures (called a GOP) during encoding to make 
the fi nal compressed fi le as small as possible. The 
Apple MPEG Encoder defaults to a 15-frame GOP 
length for NTSC video, 12 frames for PAL. Because 
you can put chapter markers only at the beginning 
of a GOP, this means that you’re limited to placing 
two chapter markers per second of run time. To 
work around this limitation and place your chapter 

Compressor continued

CLICK HERE for our 
on-line poll. Tell us 
what you liked and 
what we can improve 
in Edit Well.

 Tell Us 
What You Like!

http://www.surveymonkey.com/s.asp?u=601692169128
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markers in better context with the overall 
program, you can set chapter markers into 
the video edit in Final Cut Pro, Final Cut 
Express, or from within Compressor, prior 
to encoding the MPEG-2 stream. 

If you don’t set chapter markers prior to 
encoding, you’ll be limited to setting chapter 
markers only on the 0th or 15th frames; which 
may not be as accurate as you would like.

To assist Compressor in processing diffi cult 
scene changes without setting a chapter point, 

use Final Cut Pro to set a compression 
marker instead. This technique forces the 
encoder to create a higher-quality I-frame 
at that point, without creating an I-frame 
header and restarting the GOP sequence.

Using these tips will ensure that your 
encoding forays are less troublesome, and 
your DVD authoring endeavors more 
profi table.

Compressor continued

Figure 2 Figure 3

In this video tutorial, Larry Jordan 
demonstrates techniques you can use 
to troubleshoot and optimize your 
Final Cut system. (TRT: 14:22)

Tutorial: Troubleshooting 
your Final Cut System

Video Exclusive

click 
to 
play

Add Chapter Marker Add Compression Marker

http://www.peachpit.com/content/downloads/peachpit/editwell/ew01_trouble.mov
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To help you get your images looking great, 
this starts a multi-part series on color correction. 
In this article, I’ll explain how to use Final Cut’s 
built-in scopes, because scopes are critical 
to any color work. (See Problems with Final 
Cut’s Scopes.)

Next month, we’ll build on this introduction 
and show you how to use these scopes to 
help you make color correction decisions.

To access the scopes, either select Window > 
Arrange > Color Correction, or select 
Tools > Video Scopes.

Final Cut has four built-in scopes: Waveform 
monitor, Vectorscope, RGB Parade, and 
Histogram (see Figure 1). Of the four, the 
Histogram is the least helpful, and we won’t 
cover it in this article, except to say that it 
displays the same information in Final Cut 
as it does in Photoshop.

The View pop-up menu (upper right) 
controls which image the scope displays. 
To switch to a specifi c scope, use the 
Layout pop-up menu (upper left).

While all scopes are useful, the most 
important one to understand is the Wave-
form monitor, so our tour will start there.

Waveform monitor
While the Waveform monitor shows you 

everything you need to know about the 
black, white, and grayscale levels of an 
image, it tells you nothing about color.

In Figure 2, for example, I’ve created a 
gradient that shades from pure white on 
the left to pure black on the right. The white 
diagonal line represents the grayscale value 
of all the pixels in the picture. The higher 
the white line, the whiter the image.

Notice that the left side of the scope 
coincides with the left side of the image 

Techniques to Better Color Correction
Part I: Understanding Video Scopes

Figure 1: The four scopes of Final Cut.

Figure 2: A gradient ramp in the canvas and on the Waveform monitor.

By Larry Jordan
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and the right side of the scope represents 
the values on the right side of the image. 
The pixels shade from 100% white on the 
left, to 100% black on the right.

An image is considered broadcast safe if 
the black levels don’t go below 0 and the white 
levels don’t go above 100%. (However, many 
digital video formats shoot a white level 
greater than 100%, called “super-white,” that 
often needs to be corrected before output-
ting to tape for broadcast or distribution.)

Let’s consider another image that will better 
illustrate how to use a Waveform monitor.

Figure 3 shows an evening picture. Notice 
how the individual white dots, which represent 
pixels in the image, are shading toward black. 
There’s a bump about two-thirds of the way 
across, which corresponds to the setting sun, 
and a large clump of nearly black pixels on 
the right side that represent the shadows 
of the trees.

In contrast, notice how the pixels in the 
Figure 4 winter scene are up near 80% 
white, representing the snow and sky, while 
the trees, though darker, barely get below 
the 50% gray level.

However, the Waveform monitor tells us 
nothing about color. For that, we need the 
Vectorscope.

Figure 4: The two shades of white and gray are repeated in the Waveform.

Figure 3: Note how the waveform refl ects the differences in gray-scale in the picture.

Scopes continued
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Vectorscope
Unlike the Waveform monitor, the Vectorscope shows all white, 

black, and gray levels as an itty-bitty white dot in the center of the 
scope (see Figure 5). The Vectorscope is only used to display color.

Look at the color tubes in Figure 6. In the Waveform, the pixel values 
vary from about 10% to 90%. But notice what’s happened in the 
Vectorscope, shown in Figure 7. There are strong clumps of color 
for yellow, orange, red, green and dark blue.

The Vectorscope contains six purple boxes, called color “targets,” 
representing the three primary colors (red, green, and blue) and 
three secondary colors (yellow, cyan, and magenta). Colors are 
represented by their angle (hue) and the distance out from the 
center (saturation). Red is at the top in the 11:00 position, followed 
in clockwise order by magenta, blue, cyan, green, and yellow.

With the Vectorscope, an image is considered broadcast safe if all the 
color values are contained inside a polygon connecting the tops of 
each of the six boxes (see Figure 8). In our example, the yellow color 
is oversaturated, and should be corrected before fi nal lay-back to tape. 

Figure 5: All shades of black and white are a single dot in the center of the Vectorscope. Figure 6: The colors are clear and striking, but the gray scale values are much 
more complex.

Figure 7: On the Vectorscope the colors 
of the crayons are clearly displayed.

Figure 8: Broadcast safe colors are 
contained inside the borders of a 
rectangle connecting the tops of each 
of the six color targets.

Scopes continued
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Figure 9 contains a somewhat more typical example. Notice that 
while there are lots of colors in the image, the Vectorscope displays 
a more shaded picture, with spikes for red and blue, but lots of 
variations spreading from red to yellow, representing the variety 
of different colors and intensities in the image itself.

This is more typical of the Vectorscope – a color image contains 
lots of shades and a few spikes showing direction, but very few 
clumps of color.

RGB Parade
The RGB Parade is a special form of the Waveform monitor, in 

that it shows the amount of red, green, and blue in the picture 
(see Figure 10).

You interpret it just like the Waveform monitor; reading from left 
to right, darker shades appear toward the bottom and lighter shades 
toward the top. The difference is that you’re able to distinguish the 
shading of each of the three primary colors.

The RGB Parade comes in very handy when you’re color balancing 
an image that contains no white or gray. For now, it’s enough to know 
that the RGB Parade is a specialized form of the Waveform monitor.

Reading skin tones
When working with skin tones, all three scopes can be very 

helpful.  Assuming proper lighting, Caucasian skin runs between 
45% and 60% on the Waveform monitor; darker skin is 20–45%.

In Figure 11, for example, notice that the Waveform monitor 
shows lighter shades on the left from the white wall behind the 
subject, and darker tones throughout from the shadows in her 
hair. Most of the midrange is skin tone.

Figure 9: The Vectorscope shows the variety of color shades in this color still-life.

Figure 10: The RGB Parade shows the values of each of the three color components 
of a video image: red, green and blue.

Figure 11: Caucasian skin tones generally range from 40-60% on the Waveform monitor.

Scopes continued
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If we crop the image to remove some of the extraneous visual 
clutter, as in Figure 12, you can see more clearly how the skin tone 
is ranging from 50-60%.

Figure 13 shows the same image on the Vectorscope (left) and RGB 
Parade (right). While the RGB Parade isn’t particularly helpful with 
this image, the Vectorscope highlights the last important point I want 
to make: The thin purple line pointing northwest is called the Flesh 
Tone line.

I like this line. Whether you’re black, white, red, brown, or any 
other skin tone, your skin is given its color by the red blood pulsing 
just below the skin’s surface. The Flesh Tone line in the Vectorscope 
represents the color of blood under skin; if the skin tones in your 
image are not positioned on or really close to this line, it’s an 
excellent indication that you need to color-correct your shot.

In this example, the subject’s skin tone is rolled a little bit toward 
red, but not enough to worry about.

Summary

Here are the key points to remember as you work with scopes:

• The Waveform monitor shows video levels as shades of gray.
• The Vectorscope displays color information.
• The RGB Parade shows the video levels of the red, green, 

and blue components of an image.
• The Flesh Tone line shows whether skin tones 

in an image are correct.
• White levels over 100% are outside the broadcast safe zone.
• Saturation levels outside color targets are not broadcast safe.
• Most caucasian skin tones fall between 40–60% on 

the Waveform monitor.
With this introduction as background, next month we’ll show 

you how to use the scopes to color-correct a variety of scenes 
effectively.

Figure 12: Cropping helps to isolate a specifi c section of an image to help display its 
values on the Waveform monitor.

Figure 13: This the image of the girl in Figure 11 on the Vectorscope and RGB Parade.

Scopes continued
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Helpful as the scopes in Final Cut are, 
they aren’t perfect. 

The problem with the scopes in Final Cut 
is that they don’t sample every line of video in 
your image. Worse, they ignore all portions of 
the image outside Action Safe. This means 
that if you have a hot specular outside 
Action Safe, the scopes won’t pick it up.

The scopes are accurate for what they show. 
It’s what they don’t show that’s important.

Here’s an easy way to test this: Create an 
image of 50% gray and add a couple of pure 
white and pure black patches outside Action 
Safe. Notice that the waveform monitor shows 

the gray perfectly, but doesn’t display the 
black or white patches (see Figure 1).

Frankly, I fi nd this omission ridiculous. I’ve 
mentioned this issue to Apple, as have others, 
and my hope is that one of these days it will 
get fi xed — it’s been broken since scopes 
were fi rst added.

For now, however, be forewarned that if 
you have images with hot spots on the edges, 
the waveform may not pick it up properly.

You can solve this problem by using an 
external scope. Tektronix makes excellent 
ones. However, their standard-defi nition 
scopes range from $2,000 to $8,500.

Figure 1: Notice the white and black boxes are not displayed on the Waveform monitor.

Shortcut Result

Space bar Plays clip—
but you already knew that.

Shift+space 
bar Play backwards

Shift+p Play from playhead to Out

\ Plays around the playhead

Shift+\ Plays from the In to the Out

J+K Plays backward at 1/3 speed

K+L Plays forward at 1/3 speed

J+J 2x reverse

L+L 2x forward

J+J+J 4x speed reverse

L+L+L 4x speed forward

Problems with Final Cut’s Scopes

KEYBOARD SHORTCUTS
PLAYBACK

http://www.tek.com/products/oscilloscopes/
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Figure 1: Auto Select buttons. Figure 2: Manually selected clips.

Those gray buttons on the left side of the Timeline 
are a mystery to many. In this article, I’ll show you how 
they work and how to use them to control your 
timeline in ways you may not have imagined possible.

These buttons, and their behavior, were introduced 
in Final Cut Pro 4, and have been met with reactions 
ranging from simple shrugs and avoidance to angry, 
heated resentment and loathing. Matters were not 
improved by the fact that the Auto Select behavior 
changed in many interim versions of the application 
from v4 to v5. 

I’ll bet even a serious user like you still ignores 
Auto Select, and for much of the time that strategy 
probably works fi ne—that is until you want to do 
something with multiple tracks. To help you with 
that, here are some practical selection techniques, 
copying and pasting tips, shortcuts and other smart 
ways to use these handy little buttons. 

Selecting Clips and Ranges of Clips
There are a number of ways of selecting items or 

portions of a sequence. You can select items manually 
by clicking them with the Selection tool, by using the 

Solving the Mystery of Auto Select 
By Tom Wolsky
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Shift or Command key, by dragging a selection, or by 
using the range selection tool. (Range selection allows 
selection on only one track, however.) When these 
types of manual selection are made, the items turn 
brown, as shown in Figure 2.

You can also select items by marking In and Out 
points in the Timeline. When nothing is manually 
selected, these In and Out points defi ne a selected 
area, and the Auto Select buttons control which 

items on which tracks are selected (see Figure 3).

Notice the areas that appear highlighted on tracks 
V1, A3, and A4. These areas have been selected 
(their Auto Select buttons are dark), which means 
that those selections can be copied or deleted as a 
group. Notice the relationships of which items have 
the highlighted areas and which tracks have Auto 
Select turned on. The items on V1 and A3/A4 are 
the only ones selected; the title on V2 and the 
audio on A1/A2 are not selected and will not be 
copied or deleted. The Auto Select buttons provide 
the only way to perform this kind of complex copy 
or delete function; and this technique is most 
useful when working with clips on multiple tracks.

Auto Select vs. the Patch Panel
The patch panel in FCP controls the destination 

tracks and in turn is controlled by the contents of 
the Viewer. The connections that appear in the patch 
panel are determined by what’s in the Viewer. If the 
Viewer contains a single-layer graphics fi le, there will 
be only one patch connection, for the video track; 
there will be no patch connections for the audio. 
(Multilayer graphics fi les, or multilayer sequences 
open into the Viewer, will allow you to set multiple 
video destination tracks, and using the Command key 
will allow you to edit multiple video tracks at once.) 

Think of the patch panel as what controls how 
material is edited into the Timeline from the Viewer. 
The Auto Select buttons, on the other hand, control 
what’s edited out of the sequence, or edited into 
the sequence by pasting. The patch panel controls the 

Figure 3: Highlighted areas on V1, A3, and A4 have been auto 
selected. 

Auto select OF F

Auto select ON

Auto Select continued
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Canvas Edit Overlay, the edit keyboard shortcuts 
(F9, F10, and F11), and the Canvas edit buttons. 
Once a clip is on the Timeline, the Auto Select 
buttons control pretty much everything else in 
terms of track selection.

Pasting
After copying items, you can use the same Auto 

Select buttons to control where those items will be 
pasted. If you don’t change any Auto Select buttons, 
the default behavior in the current version of Final 
Cut is to paste back to the same tracks from which 
the items came. If you want to override this arrange-
ment and paste to different tracks, use the Auto Select 
buttons to activate the tracks to which you want to 
paste. By default, selections are pasted to the lowest 
Auto Selected track number. So if you want to paste 
to V3, turn off the Auto Select for V1 and V2 (deacti-
vated buttons are gray).  Audio tracks work in the 
same way. If you want to paste to A5/A6, A1 through 
A4 have to be switched off. Figure 3 shows active 
(black) Auto Select buttons, and inactive (gray) Auto 
Select buttons.

 My rule for using the Auto Select 
buttons for copying and pasting is: A clip will 
paste to the same track from which it is copied, 
unless, after you copy the clip, you change the 
Auto Select buttons. In which case, the clip will 
paste to the lowest-numbered track whose 
Auto Select button is dark.

Shortcuts
Option-clicking an Auto Select button selects that 

track and deselects all the others. Similarly, if a single 
track is Auto Selected, Option-clicking the Auto Select 
button turns selection back on for all the tracks. 
Setting video and audio tracks is done independently.

Pressing Command and a number on the keypad 
toggles auto selection on and off for the video 
track with that number. Pressing Option and a 
keypad number toggles auto selection on and off 
for the audio track with that number.  Although 
this is the default keyboard confi guration, be aware 
that if you switch to the keyboard Multicam Editing 
layout these keyboard controls are no longer set to 
controlling Auto Select functions, but to switching 
and cutting multicam material.

Other Auto Select Functions
Track selection for copying, pasting, and deleting 

are the primary functions that the Auto Select 
buttons control, but there’s much, much more.

You can cut through tracks with a keyboard 
shortcut that behaves like the Blade tool. The 
shortcut is Control-V. The Auto Select buttons 
control which tracks are cut with the shortcut.  
Any track with an active Auto Select button will be 
cut.  Any tracks not auto selected will be left uncut. 
If you need to cut across all the tracks when only 
some are auto selected, press the B key twice for 
the Blade All tool and then hack away.

Editor’s No
te:

Auto Select continued
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The Auto Select buttons also control the 
match frame function. When you use match 
frame, the F key will go to the lowest auto 
selected track, unless the clip under the 
playhead is actually selected by clicking it. 
(There are instances in which this trick 
doesn’t work, but it should function as 
advertised for most material.)

The Auto Select buttons also provide a 
way to load a clip into the Viewer. If you 
press the Enter or Return key while the 
Timeline is active, the clip underneath the 
playhead is loaded into the Viewer. The 
Auto Select buttons let you control which 
clip from which track in the vertical stack 
is loaded. Final Cut always loads the clip on 
the lowest auto selected track.

Another function controlled by the Auto 
Select buttons is the sequence search. Here 
you have the option to select searching 
only auto selected tracks (see Figure 4).

Using the X key to mark a clip or a gap is 
also controlled by the Auto Select buttons. 
If the track is not auto selected or if only the 

video or audio track is auto selected, then only 
that track area will be marked by the X key. 

The Auto Select buttons also give you a 
way to measure sections of a program or to 
prepare for editing into a sequence. Take a 
look at Figure 5. We all know that X marks 
the clip under the playhead in the Timeline. 
In Figure 5, I’ve marked the area with the 
missing audio section; it’s on tracks A1 and 
A2. The Canvas duration display tells me it’s 
7:14. I can use the Timeline In and Out to 
edit a piece of sound directly into that hole. 
Because only A1 and A2 are auto selected 
and have material on them, only that area 
is marked with the X key.

Shift-K and Option-K move forward and 
backward between keyframes in the Timeline. 

The Auto Select button lets you control 
which keyframes on which tracks you move 
between.  Again, the keyboard shortcuts will 
move between the lowest auto selected tracks.

Similarly, using Control-plus and Control–
minus, Control-[ and Control-] to raise 
and lower audio levels is controlled by which 
tracks are auto selected. The clips on any 
auto selected tracks will be adjusted. Clips 
on tracks with Auto Select disabled will 
not be affected.

Although sometimes Auto Select might 
seem to get in the way, making what should 
be simple more complicated than it needs 
to be, Auto Select also allows you to do 
much more, adding functionality that simply 
would not be possible without these handy 
little buttons. 

Figure 5: Track-specifi c selection area.
Figure 4: Sequence search dialog.

Auto Select continued
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